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Getting Started

transporter.props Configuration
transporter.props, if specified, is located under the config directory relative to the Transporter install 
location. This file contains transporter configuration options. 

Some configuration options which may be controlled via transporter.props are as follows:

• UseUnixId – Specifies whether to execute Unix id command to gather user info. Default is false. 
Transporter uses context information unique to the login user to encrypt sensitive data so no one else 
can comprise its secrecy. By default, this user info is gathered using 
javax.security.auth.login.LoginContext API. If the runtime platform is a Unix system and, for any 
reason, it does not fully support this API, you can set this property to true and the Transporter will 
gather user info by the id command instead.

To control logging categories and granularity, specify:

Categories of logging:

– TransporterLog – Used to control logging of general categories including non-job transports

– TransporterJobLog – Used to control logging of job transport operations

– TransporterDataLog – Used to control logging of data related operations

– TransporterUILog – Used to control logging of general UI operations

Logging Levels:

Valid options are SEVERE, WARNING, FINE, FINER, FINEST, with a default of SEVERE, if not 
Logging levels mentioned are the same as those used by Scheduler where a level of SEVERE is the 
least granular (only logging the most severe incidents) while FINEST is the most comprehensive.

To control connection timeouts specify:

– CONNECT_TIMEOUT=20000 (Used to specify a connection timeout in milliseconds; in this 
example, a time of 20 sec has been defined.

– READ_TIMEOUT=20000. (Used to specify a connection read timeout in milliseconds).

To control the number of transporter and session log files retained:

• MaxLogFiles=50 (Used to control the number of Transporter log files retained. Defaults to 50 if 
unspecified).

• MaxSessionFiles=50 (Used to control the number of Transporter session files retained. Defaults to 
50 if unspecified).

To configure Transporter for secure HTTP, specify:
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Truststore=c:\\temp\\mytruststores\\demo-truststore 

This is used to specify the fully-qualified path of the SSL trust store file to be used if you wish to connect 
Transporter to an SSL enabled Client Manager(s). A truststore file is a key database file that contains the 
public keys for target servers.

Note the use of escaped backslashes for windows directories.

If this configuration option is not specified, you will be unable to define a secured connection during the 
process of defining connection files. See “Creating a Connection”.

There are various tools that allow you to generate keys and certificates and among them is the Java 
Keytool program that comes with the Java JRE installation. All keystore entries (key and trusted 
certificate entries) are accessed via unique aliases. An alias is specified when you add an entity to the 
keystore using the -genkey command to generate a key pair (public and private key) or the -import 
command to add a certificate or certificate chain to the list of trusted certificates. Subsequent keytool 
commands must use this same alias to refer to the entity. When connecting to multiple Client Manager 
servers configured for SSL, your trust store must contain entries for each Client Manager server you 
intent to connect to via HTTPS. You can use the alias to refer to each of these servers. See your Java 
Keytool documentation for specific details.

The following configurations are available in order to provide improved performance for unfiltered job 
reads. Multiple options have been provided for flexibility and the option to be configured may require 
some tuning based on specific user environments. For tuning purpose, it is best to run Transporter in 
debug mode with an open console so that you can view how the reads are performing. To run Transporter 
in debug mode, include XPORTER_DEBUG=YES in Transporter.props and run transporter given 
transporter.cmd script located in bin.

• READJOBS_PAGINATED – configures CM to return job data in pages of READ_BATCHES 
batches. 

For example, READ_BATCHES=1000 and READJOBS_PAGINATED=true
tells CM to return job data in batches of 1000. This approach reduces the overhead on CM as data 
is sent in smaller batches, as opposed to the entire job data in one request. Increasing the 
READ_BATCHES will reduce the number of requests sent to CM, since the jobs are returned in 
larger batches. 

Note Note: This approach may have less benefit given many jobs (i.e. 50K or more). The batching is 
done at the CM level.

• READJOBS_BATCHES – Reads jobs given a range of job id’s, where the range is specified via 
READ_BATCHES.

For example, if you have 50K job records with job IDs starting at 1 and ending at 50,000, and you 
have set READ_BATCHES=1000 and READJOBS_BATCHES=true, requests will be sent to CM to query 
job records, in ranges as follows, until no more records are returned.
1. jobid >=1 and jobid <=1001

2. jobid >=1002 and jobid <= 2002

3. jobid >=2003 and jobid <= 3003

4. …

Note This approach appears to be more beneficial when there are many job records, for example, 
50,000 or more).
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• READJOBS_ALL – This reads all jobs given the first and last job id. The result is that all jobs will 
be read in a single request. This approach is different from the job.getList call in that while both 
return all jobs, this request adds a query condition to the request, which seems to produce better 
performance. However, because all records are returned in a single request, CM will need to process 
all the records for return to Transporter. If there are many job records, the overhead on CM may be 
to high.

Note Only one parameter, READJOBS_PAGINATED, READJOBS_ALL, or 
READJOBS_BATCHES should be set to “true” at a time. Parameter: READ_BATCHES 
applies to READJOBS_PAGINATED or READJOBS_BATCHES.
If none of these parameters is set, the default configuration for read defaults to 
(READ_BATCHES=500, READJOBS_BATCHES=true)

Understanding the Transporter Interface
Start Transporter by clicking Start and selecting Programs>TIDAL 
Software>Transporter>Transporter to display the Transporter interface. 

The Transporter main selection screen is divided into two sections with a Source and Destination side. 
Once connected to their respective source and destination, each side displays data objects that can be 
matched to its corresponding mate in the opposite window. A tabbed view of Transport data types is 
available for selection. Source and Destination object lists are merged into a single table view where 
matching Source and Destination objects are lined up in the same row for easy viewing. As a 
consequence, if the Source and Destination data is very different, there may be gaps in the display. For 
added control over the display, two Preference options are available to control destination display. Refer 
to “Preferences”. 

Note You can adjust the size of these windows by moving the center bar left or right.

Transporter uses a combination of menu options and a toolbar to access and manage the copying of data 
objects between source and destination. 

Main Menus
Transporter contains the following main menus:

• File

• Preferences

• Search

• Transport

• Actions

• Reports

• Help
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File

The File menu manages the access and loading of file information and Transporter operation. This menu 
contains the following options:

• Connections – Displays the Connections dialog. This dialog is used to create and modify existing 
connections to a source and destination using connection files. Connections files are created in the 
user's transporter home directory. 

For example:

– C:\Documents and Settings\<user>\.transporter

Note The user information is encrypted in the file, using Triple DES Encryption.

Clicking  on the toolbar is the same as selecting the Connections option.

• Connect – Establishes connections to the source and destination. Once connections are established, 
the Connect option is unavailable; only the Disconnect option is available. 

Clicking  on the toolbar is the same as selecting the Connect option.

• Disconnect – Ends the current session as well as the connection to the source and destination sides. 
Once the connection ends, the Disconnect option is unavailable; only the Connect option is 
available.

Clicking  on the toolbar is the same as selecting the Disconnect option.

• Configure – Displays the Configuration Options dialog to customize Transporter for working 
preference. 

Clicking  on the toolbar is the same as selecting the Configure option.

• Read Data – Reads data from both the source and destination for the currently selected object type.

Clicking  on the toolbar is the same as selecting the Read Data option.

• Refresh All – Disconnects and then reconnects to the selected sources.

• Save Map – Displays the Save Tidal Scheduler Map File dialog to save the object mappings that 
have been selected during the current session. The file name you provide is assigned a .map 
extension. You can avoid repeating the manual mapping process for jobs if jobs with the same data 
objects need to be copied again by saving the object map.

• Save Selections (Applies to jobs only) – Displays the Save Selection to File dialog to save the job 
objects selected in the main text field of the source tree. The file name you provide is assigned a .xpr 
extension. Save job selections if you do not want to repeat the same selection process in a future 
session or you want to schedule Transporter in batch mode. Refer to “Running Transporter in Batch 
Mode”.

• Load Selections – Displays the Open Selection File dialog to select and load a selection file that 
was saved from a previous Transporter session.

• Exit – Ends the Transporter session and closes the Transporter application.

Preferences

The Preferences menu allows you to manipulate how data is viewed in the Destination window. This 
menu contains the following options:
3-14
Cisco Tidal Enterprise Scheduler Installation Guide

OL-32205-01



Chapter 3      Getting Started
Understanding the Transporter Interface
• Show Unmatched Destination Items – Displays destination objects that have no matching source 
only. The default is False.

• Show Duplicate Destination Objects – Displays destination objects that have a matching source. 
The default is True.

Note If both options are set to OFF, no text displays in the Destination window.

• Expand Groups on Read – Expands all job groups in the current view upon read.

• Collapse Groups on Read – Collapses all job groups in the current view upon read.

Search

The Search menu helps you sort through a potentially large number of data objects that may be displayed 
in the source list. This menu contains the following options:

• First – Finds the first match for the criteria entered in the Search Text field. 

Clicking  on the toolbar is the same as selecting the First option.

• Next – Finds the next match for the criteria entered in the Search Text field. 
Clicking  on the toolbar is the same as selecting the Next option.

• Filter – Displays the Job Filter dialog that provides various text fields to filter the available 
jobs/groups that are displayed in the source. 

Clicking  on the toolbar is the same as selecting the Filter option.

Note To search on data against the destination list, right-click on the Destination pane and select Find First 
or Find Next from the following menu options: 
Find First – Finds the first destination match for the criteria specified in the Search text field. 
Find Next – Finds the next destination match for the criteria specified in the Search text field. 

Transport

The Transport menu organizes the tasks directly concerning the copying of object data. This menu 
contains the following options:

• Mappings – Displays the Scheduler Object Mapping dialog to map the various data objects 
between the source and destination.

• Synchronize – Copies all objects listed in the source listing to the destination. Normally a user 
would not want all of their jobs to be copied at once. The user would select which objects should be 
copied to the destination.

Depending upon the number of objects in the source, using the synchronize option may require a 
lengthy amount of time to complete.

• Start Transfer – Begins the copying process of the selected objects between the source and 
destination. 

Clicking  on the toolbar is the same as selecting the Start Transfer option. 
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Actions

The Actions menu groups together options affecting the operation of the TES Master and its job 
schedule. This menu contains the following options:

• Pause Scheduler – Pauses the destination TES Master.

• Create Schedule – Recompiles the destination production schedule for the current or future day.

Reports

The Reports menu provides ready access to the main reports and logs provided by Transporter. Reports 
are HTML based and viewed via the system's default browser. This menu contains the following options:

• Mappings Report – Displays the Scheduler Object Mapping Rules report that details the source 
objects that are currently mapped to corresponding destination objects. Recall that the purpose for 
mapping source object to destination objects is to automate the transporting process. 

• Invalid Mappings – Displays a report of mappings that are no longer valid. Mappings may no longer 
be valid if the object was renamed or deleted in the destination. Therefore, no valid mapping 
between a source and destination object can be established.

• Last Activity Log – Displays the Activity Log report for the last transfer operation of the current 
Transporter session.

• Current Session Log – Displays the Activity Log report containing the complete activity log of the 
current Transporter session.

• Past Session Log – Displays the Open Past Activity Log File dialog to select a log file from past 
Transporter sessions. Session logs for Transporter are saved with transporter-timestamp.sess format 
where the timestamp that the session occurred on is affixed as part of the name. Timestamp has the 
format: yyyyMMddHHmmssSSS. 

Help

The Help menu provides information on the version of Transporter and how to use the application. 
Selecting this option launches your default Web browser and allows you to search for a topic. This menu 
contains the following options:

• About – Displays the splash screen for Transporter. The version number of Transporter is displayed 
here.

• Contents – Displays the online help system. You can search for a topic from the Help system’s table 
of contents or use the Search or Index features. 

Toolbar/Buttons 
The toolbar provides one-click access to some of the most frequently used features during a Transporter 
session. The buttons are arranged from left-to-right in approximately the same sequence needed during 
a typical session. The buttons duplicate the same options that are available in the main menu but provide 
more convenient access. The buttons and their purpose are:

•  Source – Launches the Tidal Web Client in your default Web browser for the selected 
source.

•  Destination – Launches the Tidal Web Client in your default Web browser for the 
selected destination.
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•  Connections – Displays the Connections dialog. This dialog is used to create and modify 
existing connections to a source and destination using connection files.

•  Connect – Establishes a connection to the items selected in the Source and 
Destination fields. Once the connection is established, the button changes to Disconnect and when 
clicked ends the connection. Clicking this button is the same as selecting the Connect option in the 
File menu. (A complete refresh of all data objects is accomplished during a session by disconnecting 
and reconnecting.)

•  Disconnect – Ends the connection to the items selected in the Source and Destination 
fields. Once the connection ends, the Disconnect option is unavailable. Only the Connect option is 
available. Clicking the Disconnect button on the toolbar is the same as selecting the Disconnect 
option. (A complete refresh of all data objects is accomplished during a session by disconnecting 
and reconnecting to the source and destination.)

•  Read Data – Reads the object data for the definitions from the selected source and 
destination. Clicking the Read Data button is the same as selecting the Read Data option from the 
File menu.

•  Start Transfer – Begins the data copying process between the selected source and 
destination. (Job transports provide for interactive mapping by transferring individual jobs or job 
groups.) 

Clicking the Start Transfer button is the same as selecting the Start Transfer option in the 
Transport menu. 

Note For Job transports, an individual job or job group can also be transported by dragging and dropping a 
source job or job group to a destination group. Be careful not to drop the job inside the wrong job group 
in the destination inadvertently.)

•  Filter – Displays the Job Filter dialog that provides various filter criteria for filtering of 
jobs/groups that are displayed at the source. 

Clicking the Filter button is the same as selecting the Filter option in the Search menu.

•  Mappings – Displays the Scheduler Object Mapping dialog where the various objects 
from the source can be associated with corresponding destination objects. 

Clicking the Mapping button is the same as selecting the Mapping option in the Transport menu.

•  Configure – Displays the Configure Options dialog to customize Transporter to work 
according to your preference. 

Clicking the Configure button is the same as selecting the Configure option in the File menu.

•  Find – Highlights the first source data object that matches the criteria entered in the search 
text field.

•  Next – Highlights the next source match for the criteria entered in the search text field.

Note To Search on data against the destination list, right-click on the Destination pane and select Find First 
or Find Next from the available menu options available. 
Find First – Finds the first destination match for the criteria specified in the Search text field. 
Find Next – Finds the next destination match for the criteria specified in the Search text field.

• Status Panel – Located at the bottom of the Transporter screen, this panel displays the number of 
objects selected for transport as well as other status messages.
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Tabs
The main Transporter selection screen contains a tabbed view of the following Transport Data types: 

• Jobs/Groups – Displays job and job group definitions that can be copied from the source to the 
destination. 

• Calendars – Displays calendar definitions that can be copied from the source to the destination.

• Business Views – Displays business views that can be copied from the source to the destination.

• Variables – Displays variable definitions that can be copied from the source to the destination.

• Events – Displays the event definitions that can be copied from the source to the destination.

• Resources – Displays resource definitions that can be copied from the source to the destination.

• Actions – Displays action definitions that can be copied from the source to the destination.

• Job Classes – Displays job class definitions that can be copied from the source to the destination.

Securing Transporter
A valid Scheduler user is an LDAP user with a user record in the Tidal Database.

When a user logs in to the Client Manager, it sends the username and password to the LDAP server to 
be authenticated. If the user is disabled in LDAP, that user is not authenticated. Once the user is 
validated, the TESPlugin determines what security policies are in effect for the user. 

Given this, there are two levels of security for a Transporter User. First, the Transporter user must be a 
valid LDAP user in order to access Client Manager for data access via the Transporter application. Once 
the user is authenticated against LDAP, the user's access rights are determined given their Tidal security 
configuration and/or rights to access the data object.

These are the same general requirements required by TES 6.2; refer to TES v. 6.2 documentation for 
further information. Additionally, there are two general security functions specific to Transporter. These 
are Move Jobs to Production and Move Own Jobs to Production. Move Jobs to Production allows a 
Transporter user to transport objects independent of ownership. Move Own Jobs to Production allows a 
Transporter user to transport only owned objects. The Transporter user's ability to access data objects 
for transport is configured given ownership and security policies from the Tidal Web client.

Note A user who has been defined as a Super User has full transport abilities without regard to object 
ownership nor Transporter Security Functions (Move Jobs to Production and Move Own Jobs to 
Production

Note When changing user security policies, Transporter will not automatically update the list of displayed 
data objects, given new policy updates. You should read again via the Read button anytime data is altered 
externally from Transporter. Additionally, for Security policy updates, it will take some time for the 
Client Manager to apply the security updates. If after re-reading data, and the data is still not reflective 
of the user policy updates, Disconnect, Connect and then Read. This will force an immediate update.
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Defining a User in TES
A Transporter user is an interactive user that is either a super user or a non-super user with a specific 
security policy.

To define a user in TES:

Step 1 From the Navigator pane, select Administration>Interactive Users to display the Users pane.

Step 2 Right-click and select Add Interactive User from the context menu, or select and existing user and 
choose Edit Interactive User to display the User Definition dialog.

Step 3 If this is a new user definition, enter the new user name in the User/Group Name field.

Step 4 For documentation, enter the Full Name or description associated with this user.

Step 5 In the Domain field, select a Windows domain associated with the user account required for 
authentication, if necessary.

Step 6 In the Windows/FTP field, enter the password and confirmation password.

Step 7 Click OK to add or save the user record in the Scheduler database.

Authorizing Schedulers to Work With Transporter Data Objects
To define a Security Policy:

Step 1 From the Navigator pane, select Administration>Security Policies to display the Security Policies 
pane, listing all defined security policies.

Step 2 Right-click and select Add Security Policy from the context menu, or select an existing policy and 
choose Edit to display the Security Policy Definition dialog.

Step 3 On the Functions tab, double-click the General category and select the functions to be authorized under 
this policy.

There are two General security functions specific to Transporter, Move Jobs to Production and 
Move Own Jobs to Production. Move Jobs to Production allows a Transporter user to transport 
objects independent of ownership. Move Own Jobs to Production allows a Transporter user to 
transport only owned objects. Super Users have full access to transport objects independent of 
ownership and security policies.

Step 4 Click OK to close the General dialog.

Step 5 Click OK to save the policy.

Note When changing user security policies, Transporter will not automatically update the list of displayed 
data objects, given new policy updates. You should read again via the Read button anytime data is altered 
externally from Transporter. Additionally, for Security policy updates, it will take some time for the 
Client Manager to apply the security updates. If after re-reading data, and the data is still not reflective 
of the user policy updates, Disconnect, Connect and then Read. This will force an immediate update.
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Creating a Connection
Data resources are requested given an HTTP (or HTTPS secured connection), client connection using 
HTTP Basic Authentication. Refer to your TES documentation for more information regarding SSL 
enabled Client Manager configurations.

Connection details are created via the Connections dialog where connection files containing connection 
attributes for establishing connections are created.

To create a connection:

Step 1 In the Connection Name field, enter the name for the connection file.

Step 2 In the Server Name field, enter the name of the Tidal Client Manager machine.

Step 3 In the Master Name field, enter the master instance name.

The master instance name is the TES DSP or Plugin name. This is displayed from the Web UI in the 
Master Status pane.

Step 4 In the Server Port field, enter the listening Web Service port used by the Tidal Web Client. The default 
is 8080 for non-secured connections and 8443 for secured connections.

Step 5 In the User and Password fields, enter a valid TES user name and password. 

Step 6 Select the Secure HTTP option if you want to connect securely through the HTTPS protocol. 

This option is enabled only if Transporter has been configured for secure connections. 

For instructions on configuring Transporter for secure HTTP, see Page 11.

Step 7 Click Save.

The connections file is created in the user's Transporter Home directory. 

For example: 

– C:\Documents and Settings\<user>\.transporter

Note The user information is encrypted in the file, using Triple DES Encryption.

The Connections dialog also contains the following elements not discussed in the procedure above:

• New – Click to create a new connection.

• Rename – Click to rename an existing connection.

• Delete – Click to delete a connection.

• Test – Click to test an existing connection.

• Exit – Click to exit the Connections dialog.

Establishing a Connection
To establish a connection:

Step 1 Select a source from the Source list. 
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Step 2 Select a destination from the Destination list.

Step 3 Once the source and destination are selected, click the Connect button on the toolbar to connect to the 
source and destination.

After the connections are established, click the Read Data button to display a list of data objects based 
on the currently selected data types. This is done automatically if the Read on Connect or New Data 
Type configuration option is selected. After the connections are established, the source and destination 
displays a list of data objects based on the currently selected data types.

Once connected, the Connect option in the File main menu is unavailable and toggles to the Disconnect 
menu option.

If Transporter is currently connected, then the Source and Destination lists are unavailable.

To select other sources, you must first disconnect from the current connection by clicking the Disconnect 
button or selecting the Disconnect option from the File main menu.

Once connected, you can either configure a set of Transporter options or you can Read Data and then 
start selecting the data objects in the source that you want to copy to the destination.
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